Using gradients is the easiest way to depart from the lifeless flat look of solid color fills, and as such, gradients are one of the most important features of vector graphics. Designers can create amazingly complex and photorealistic art using nothing but carefully laid out gradients. For all their versatility, gradients are relatively simple to create and edit, render quickly, and are almost universally supported in SVG software—none of which is quite true, for example, for SVG filters such as blur (17.1).

Basically, a gradient is a smooth transition between two or more colors. Color also includes a level of opacity; this means that you can, for example, make a gradient from opaque red to transparent red, with semitransparent red shades in between. SVG supports two types of gradients: linear (along a line) and elliptic, or radial (away from a center, with possibly unequal axes and a noncentral focus point).

10.1 The Gradient Tool

The Gradient tool (g or Ctrl-F1) is where you create new gradients on objects. It is also the best environment for editing existing gradients—even though, once created, a gradient on a selected object can be edited (by dragging handles and...
assigning colors to them) not only in the Gradient tool but also in the Node tool (12.5), all shape tools (Chapter 11), and in the Dropper tool (8.6). Still, the Gradient tool has a number of gradient-specific editing conveniences.

Creating a new gradient is very simple: Make sure you have the necessary object or objects selected and drag on the canvas. You will see an actual gradient appearing and following your mouse as you drag, and you will also see a system of handles (small on-canvas controls) connected by lines.

You don’t need to drag on the selected objects—gradient handles can very well lie completely outside the object they apply to. You can have any number of objects selected and get them all painted by the same gradient (more precisely, by multiple but coinciding gradients) with a single drag. Another method to quickly create a gradient that spans the entire object is to double-click that object with the Gradient tool.

To use the most common object selection shortcuts, you don’t need to switch to the Selector tool; click to select, Alt-click to select under, and Shift-click to add to selection all work in the Gradient tool as well.

Gradients can be applied to the fill of objects, their stroke, or both (8.1.1). In Inkscape, stroke gradients use greenish connecting lines between the handles, while fill gradients use blue lines:

![Figure 10-1: Different gradients on the fill and stroke of an object](image)

If you are creating a gradient for an object that had flat color paint before, the gradient will go from the fully opaque to the fully transparent version of the color of the object on which you started the drag. For example, if you have a yellow rectangle selected and drag starting from that rectangle, you will fill the object with a gradient going from opaque yellow to transparent yellow. You can, however, fill it with an opaque-blue-to-transparent-blue gradient if you have a blue-filled object somewhere and start dragging from it. To put it another way, the gradient you create applies to selected objects, but the color it uses may come from any object, selected or not, from which you start your drag. (If that’s not what you wanted, don’t worry—it’s very easy to change gradient colors once it’s created.)

Similarly, if the object where you started your drag already had some gradient, the tool will just redraw it for the selected object, preserving the colors of that gradient (i.e., preserving the gradient definition, 10.2). If you start dragging from
an empty space and not from any object, the color or gradient of the topmost selected object will be used for the new gradient.

Of the many ways to remove gradients from an object, perhaps the easiest is to make sure none of the gradient handles are selected (all are white, not blue) and click any color on the palette. The object will be filled by the flat color, replacing any gradient it had before.

NOTE Neither gradients nor any other paint (8.1.1) can be applied to bitmap objects (Chapter 18); if you want a transparency gradient applied to a bitmap, use a mask (18.4). The same is true for clones (Chapter 16), except where the paint of a clone’s original is unset.

Let’s now look in more detail at the two types of gradients Inkscape can create: linear and elliptic.

10.1.1 Linear Gradients

A linear gradient goes along a straight line, where both ends (as well as, possibly, some points in the middle) have certain colors and opacities assigned to them. The transitions between color areas on the object are always perpendicular to the gradient line. This is the default kind of gradient that the Gradient tool creates; the linear gradient mode of the tool is set by the first toggle button in the tool’s controls bar, as shown here:

Figure 10-2: Creating linear gradients by dragging and double-clicking

NOTE In the selected style indicator, linear gradients are marked with the letter L, followed by the gradient swatch.

A linear gradient has two freely draggable handles: a square one at the start and a circular one at the end of the gradient line. By dragging them around, you can change the direction and length of the gradient (note how the gradient repaints itself in real time as you drag a handle).

With Ctrl pressed, drawing a new gradient or dragging a handle of an existing one makes the gradient line snap to angle increments, by default every 15 degrees (this value is changeable in the Steps tab of the Inkscape Preferences dialog, compare 6.3). Double-clicking an object in linear gradient mode creates a horizontal linear gradient that goes through the center of the object’s bounding box.
10.1.2 Elliptic Gradients

To switch the Gradient tool to creating elliptic gradients instead of linear, press the second toggle button in the tool’s controls bar (above the canvas). Now, if you drag on canvas with some objects selected, an elliptic gradient for them will be created:

![Figure 10-3: Creating elliptic gradients by dragging and double-clicking](image)

**NOTE** In the selected style indicator, elliptic gradients are marked with the letter R (for Radial) followed by the gradient swatch.

An elliptic gradient has at least three draggable handles—the center (square handle) and the two perpendicular radii (round handles). This makes it possible to move, stretch, squeeze, or rotate such a gradient; you can make it into anything from a circle to a narrow ellipse, rotated at any angle. Moving the center handle moves the entire gradient (i.e., all handles); moving the radii stretches and rotates the gradient without moving the center. The two radii always remain perpendicular. As in the linear gradient mode, dragging a radius with Ctrl pressed snaps it to 15-degree angle increments.

When you start a drag creating a new gradient, you are dragging one of the radii; the other one gets created to be equal to half of the selected object’s height. This means that if you start dragging from the center of the object and drag horizontally to the right edge of its bounding box, the ellipse will be neatly inscribed into the bounding box. The same effect can be achieved simply by double-clicking an object.

**NOTE** If you need a symmetric “bilinear” gradient with a mountain-like profile, the easiest way to do this is via an elliptic gradient with one radius made very long, dragged far beyond the boundaries of the object. Then, the central part of the stretched ellipse will look almost indistinguishable from a couple of counter-directed linear gradients.

An elliptic gradient also has a fourth, normally hidden, handle—the focus. This is the point with the color and opacity of the gradient’s central stop. Normally, it is merged together with the central handle and moves with it, producing a perfectly symmetric gradient. You can, however, separate the focus—visualized by an X-shaped handle—from the center by dragging away from the central handle with Shift. This creates an asymmetric, eccentric gradient, shown in Figure 10-4. To merge the focus back, just drag it close enough to the central handle and it will snap.
10.2 Gradient Definition

Every gradient has a set of stops, each with its own color and transparency value. The minimum number of stops is the two end stops, in which case they apply to the ends of the gradient line (linear) or to the center and edges of an ellipse (elliptic). However, a gradient can also have any number of middle stops, each one having, along with its own color and transparency, a certain position between the end stops (for example, a middle stop may be at 0.5 of the gradient—that is, exactly in the middle between the end stops). For each gradient, the full set of its stops with their colors, transparencies, and positions is called the gradient definition.

Gradient definitions are document-wide resources. This means that any gradient you create or edit adds its definition to the list of all gradient definitions in the document. After that, you can assign that definition not only to the original gradient but to any other gradient in this document. The drop-down list in the controls bar of the Gradient tool displays swatches for all gradient definitions in the document:

![Gradient Definition Diagram]

Figure 10-5: Choosing a gradient definition

The same list of gradient swatches is available in the Fill and Stroke dialog. When you have one or more objects with gradients selected, choosing a definition from the list will assign it to all selected gradients. This does not change the position of the end handles, but replaces the colors and may add or remove middle stops.

NOTE As of this writing, there’s no way to save and reuse gradient definitions across documents, but this is planned for a future release. Also, there is no way to rename a gradient from its default numeric name (other than by using the XML Editor).
You can reverse the color definition of the selected object’s gradient by pressing \[\text{Shift-R}\]. For example, if you have an elliptic gradient with opaque blue in the center and transparent yellow at the edge, after pressing \[\text{Shift-R}\] you will have transparent yellow in the center and opaque blue at the edge. (With a linear gradient, this is equivalent to rotating the gradient line by 180 degrees, but an elliptic gradient can’t be reversed simply by moving its handles, which makes \[\text{Shift-R}\] especially useful.)

By the way, if you want to change the opacity of all stops in a gradient by the same amount, you don’t need to tweak the opacity of each stop separately. Instead, simply adjust the master opacity of the object that is using the gradient (8.1.2).

10.2.1 Sharing Gradient Definitions

When copying and pasting or duplicating an object with gradient, the object’s copy automatically gets a copy of the original gradient, so that modifying it does not affect the source object’s gradient definition. This behavior is controlled by the Prevent sharing of gradient definitions checkbox on the Misc tab of the Inkscape Preferences dialog. It is checked by default; if you uncheck it, then copying and pasting, duplicating, pasting style, and explicit assignment of an existing gradient definition to an object via the Gradient tool controls will result in a shared gradient definition. When two objects share a gradient definition, changing the colors or middle stop positions of the gradient on one object (but not changing the coordinates of the end handles) affects all the other objects that use the same definition.

The Vacuum Defs command in the File menu removes, among other things, any leftover unused gradient definitions that may be lingering in your document. It’s a good way to tidy things up and reduce the document size a bit.

10.3 Gradient Repeat

As we’ve seen, gradient handles don’t need to coincide with the edges of the object they apply to; they can be positioned absolutely anywhere on the canvas, and the object will just display whatever part of the gradient happens to fall within its limits. This, however, invites the question: What will be used to paint those parts of the object that are not covered by the gradient—those parts that are beyond the ends of a linear or outside the edge of an elliptic?

By default, these areas are painted by the flat color and transparency of the first or last gradient end stop. For example, if you have a small elliptic gradient with semitransparent white at the radii, the rest of the object outside the gradient will also be semitransparent white. However, this is not the only possibility.

Select an object with a gradient (but make sure that none of the handles are selected) and in the Repeat list of the Fill and Stroke dialog, select either reflected or direct instead of the default none. These options force the gradient to repeat itself indefinitely, either unchanged (direct), or with inversion of every second copy (reflected). This is an easy way to create various striped patterns on objects, as shown in Figure 10-6.
10.4 Handles

Handles are the on-canvas controls that correspond to the gradient stops. In the Gradient tool, they can be not only freely dragged around, but also selected and painted, much the same as selected objects are painted.

10.4.1 Selecting

Selected handles are blue, unlike the unselected ones which are white. The simplest way to select a handle is by clicking it; you can also Shift-click to add a handle to selection or remove it from selection, or Shift-drag around multiple nodes to select them with a rubber band (compare 5.7). After you have created a new gradient by dragging, the handle you’ve been dragging remains selected.

Similar to the Selector tool, in the Gradient tool you can also select handles with the keyboard: Tab and Shift-Tab select the next and previous handle (or first and last, if none were selected before), Ctrl-A selects all handles in selected objects, and Esc deselects any handles (but leaves the objects selected; a second Esc deselects objects).

Watch the status bar (2.6): It always displays useful information on the selected gradient handle(s) as well as the object(s) and gradient types they belong to.

10.4.2 Painting

You can assign any color or level of transparency to the selected gradient handle or handles, using all the same methods you would use to change the style of an object (8.1). When a handle is selected, the palette, the Fill and Stroke dialog, the color gestures and commands in the selected style indicator (8.1.1), the Paste Style command, and even the Dropper tool all work on the selected handle, not on selected object. Figure 10-7 shows an example.

Unlike an object, a gradient stop does not have fill or stroke (even though the gradient itself can apply to fill or stroke). Therefore, when you have one or more stops selected, the style indicator in the status bar shows the color of the stop in both fill and stroke swatches; this may not be perfectly logical, but it is handy. The opacity of a gradient stop is reflected by the master opacity control (labeled O: in the status bar). The displayed stroke width, however, is always that of the object (if it has stroke), not a stop, since stops cannot have any strokes.
It is especially convenient to use the Dropper tool if you want one end of the gradient to blend smoothly into other objects; make sure the corresponding handle is selected, switch to Dropper, and click the area into which you want it to blend. (Note that by switching to the Dropper tool, you leave the Gradient tool, but this is not a problem; like many other tools, Dropper displays gradient handles and even preserves handle selection. You cannot select objects in Dropper, but you can switch gradient handle selection.)

When multiple gradient handles are selected, the selected style indicator displays the averaged color and opacity of the selected stops (this is the same behavior as for multiple selected objects, 8.2.1).

When at least one handle is selected, the Copy command (Ctrl-C) copies to the clipboard the style (both color and opacity) of the single selected handle, or the averaged style of several selected handles. This means you can copy and paste style between gradient stops—select a handle, copy, select some other handle(s), and paste style (Shift-Ctrl-V). If you select several handles, this allows you to quickly average their actual colors and opacities by copying and pasting their style back onto them.

**10.4.3 Moving, Merging, and Snapping**

You can move the selected gradient handles by directly dragging them with the mouse, or by the arrow keys with all the regular modifiers (Shift for ten times the standard 2 px displacement, Alt for pixel-size displacement, Shift-Alt for 10 pixels displacement; see 6.5.1). Naturally, the end stop handles (gradient ends in a linear, center and radii in an elliptic) can be moved arbitrarily, whereas the middle handles can only be moved along the gradient line. (Don’t confuse middle handles with the center handle of an elliptic gradient; the latter, despite being in the center of an ellipse, represents an end stop of the gradient definition.)

If you selected multiple objects, all those that have gradients will display their handles (regardless of whether they are linear or elliptic, on fill or on stroke) and allow you to edit any of them simultaneously. This opens up interesting possibilities. For example, you can select ends of all linear gradients and move them all in parallel. Or, you can press Ctrl-A to select all stops in all gradients and use arrow keys to move the entire ensemble of gradients as a whole.

What’s more, any number of end stop handles (but not middle stops) can be merged. Just move one handle close enough to another, and it will snap to it and merge. (The status bar will report the merged status of such a handle, for example handle merging 2 stops.) Now, when you drag such a merged handle, it will...
affect all gradients it belongs to at once. To separate merged handles, drag away from a merged handle with $\text{Shift}$.

For example, you can merge the centers of two objects’ elliptic gradients, merge an elliptic handle with another object’s linear handle, merge all three elliptic handles of multiple objects, or merge the gradients on fill and stroke of the same object:

![Figure 10-8: Merging gradient handles](image)

When you drag to create a new gradient with several objects selected, you get what looks and acts like a single gradient applied to multiple objects but is in fact many gradients with their handles merged together.

If two handles have different colors or opacities, they will remain different after you merge them. However, if you assign a color or opacity to a merged handle, it will apply to all gradient stops sharing this merged handle, equalizing their styles. If you want to change the style of one of the merged handles without unmerging it, this is possible if the merged handles belong to different objects: Simply deselect everything (both handles and objects) and select only the object whose handle you want to repaint.

When being dragged by the mouse, all handles of an object’s gradient snap to the edges of the object’s bounding box, its central axes, and their continuations (apart from snapping to the regular snap destinations such as guidelines or grid, 7.3). This makes it easy, for example, to place a gradient handle exactly in the center of the object. Also, when dragging a handle or when creating a gradient, holding $\text{Ctrl}$ snaps the gradient angle to horizontal, vertical, and 15-degree increments in between:

![Figure 10-9: Snapping gradient handles](image)
10.5 Multistage Gradients

A gradient that has at least one middle stop between the end stops is called multistage because it contains more than one color transition. In such a gradient, each middle stop has its own color and transparency, but its position is limited to somewhere in the middle between the end stops. In Inkscape, a middle stop is represented by a diamond-shaped handle, as shown in Figure 7 on the color insert.

10.5.1 Creating Middle Stops

To add a middle stop in a gradient, double-click or Ctrl-Alt-click anywhere on the gradient line. The new stop will automatically get the color and transparency of the clicked point, so that the look of the gradient remains unchanged.

Also, you can drag and drop a color from the palette onto the gradient line. Dropping a color on an existing handle changes the color of that stop; dropping it anywhere else on the gradient line creates a new stop with this color. Also, when two or more adjacent handles are selected, pressing Insert adds new stops in the middles of all selected stop intervals (much the same as it does for nodes in the Node tool, 12.5.3). New handles added by Insert are included in the handle selection, so pressing Insert repeatedly adds more and more handles; if you start with two handles selected and press Insert n times, you will end up with a total of $2^n$ handles.

To delete all selected stops, just press Delete. Individual stops (selected or not) can also be deleted by Ctrl-Alt-clicking them.

Deleting is not limited to middle stops; you can delete an end stop as well, so that the nearest intermediate stop becomes the new end stop of the gradient. If you delete an end handle in a linear gradient or a radii handle in an elliptic gradient, the remaining handles do not move, so the gradient span becomes shorter as a result. If you delete the central handle of an elliptic, its nearest handle moves to become the new center. Finally, if you delete an end handle in a two-stop gradient, the gradient disappears and the object gets painted with the flat color and opacity of the last remaining stop.

Pressing Ctrl-L with some intermediate stops selected simplifies the selected portion of the gradient, removing those stops that can be removed without noticeable change in the look of the gradient (compare 12.3). In particular, new stops created by double-clicking or pressing Insert initially do not change the appearance of the gradient, and simplifying will delete all redundant stops that weren’t moved or repainted since creation. (You may have to press Ctrl-L repeatedly to delete all unneeded stops.)

10.5.2 Moving Middle Stops

Naturally, a middle stop’s handle can only be dragged or moved with arrow keys along the gradient line no further than its neighboring handles. Dragging a middle handle with Ctrl snaps it to 1/10 fractions of the available range—that is, it will snap to 1/10, 2/10, 3/10, and so on of the span between its neighbors.
Two or more middle stops may coincide. If they have different colors, the gradient in that point will have a sharp color boundary. For example, add two middle stops, paint one green and the other blue, and then drag the green one all the way to the blue one to create a sharp green-blue boundary in the gradient.

Dragging multiple selected handles with Alt pressed moves each one by a distance which depends on how close that handle is to the one that is being dragged. The handle which you grab and drag moves all the way, but all other selected handles lag behind, the more so the farther they are from the handle you drag (these distances are calculated using a smooth bell-like curve, similar to the node sculpting feature in the Node tool, 12.5.7.2).

Why is this useful? One gradient feature Inkscape (and SVG in general) lacks is profiles, which means you cannot make the transition between colors accelerating or decelerating (i.e., shifted towards one of the two neighboring stops) instead of linear. Yet, Alt-dragging of middle stops makes it easy to approximate such nonlinear profiles. For example, if you have a two-stop gradient that you want to shape according to a curve profile, select both ends of the gradient, press Insert several times to add a number of intermediate handles, then Alt-drags a handle in the middle to smoothly reshape the gradient:

![Figure 10-10: Approximating a profiled gradient by dragging middle stops with Alt](image)

10.6 Transforming Objects with Gradients

Normally, when you transform (i.e., move, scale, rotate, or skew, see Chapter 6) an object that uses gradient on fill or stroke, the gradient handles are transformed along with the object, so the gradient stays firmly put in place. However, the third Affect button on the Selector tool controls bar (6.10) can change that.

If you uncheck this button (checked by default), gradients will remain fixed relative to the canvas, no matter how you transform the objects that use them. This can be useful, for example, if you want to scale an object up or down so its size matches that of the elliptic gradient it uses.

10.7 Gradient Tips and Examples

If you want to “fade out” or “feather” the edge of an object, you don’t have to (indeed, often you can’t) apply a color-to-transparent gradient to it. One way to address this need is by using a mask (18.4); however, in many cases, if the background under the object is a solid color, an overlay object—a shader—of
the same color as the background with opaque-to-transparent gradient would be easier to create and maintain. This method works equally well for multiple objects that need to be feathered as a group, for feathering more than one side, for objects that already have different gradient fills, or for bitmaps or pattern-filled objects.

In this example, four gradient shaders are put over the edges of a bitmap to feather it out on a white background:

![bitmap object](image1)  ![gradient shader](image2)  ![edges feathered out](image3)

**Figure 10-11: Feathering the edge of a rectangular object with linear gradient shaders**

When using shaders, normally you don’t need to move the gradient handles to put the gradient where you need it. Instead, just transform the entire shader object with that gradient. In Figure 10-12, the Gradient tool was only used twice: to create opaque-to-transparent elliptic gradients on two ellipses, one white and one black. Then, a total of 29 clones (linked copies) of these shader ellipses, variously scaled and rotated, all with various reduced master opacity levels, were used to add depth to the cartoon face.

![original flat-color drawing](image4)  ![white shader](image5)  ![black shader](image6)  ![shaded drawing](image7)

**Figure 10-12: Adding depth to a cartoon with elliptic gradient shaders**

One problem with black (or any other dark-colored) shaders is that they often look too blunt at the edges, too definite, especially if you make them opaque enough. This is the result of the default gradient profile being linear, and therefore it can be fixed by adding mid stops and “profiling” them by Alt-dragging (10.5.2). Another useful approach is blurring the shader a bit so that its edges become less pronounced (17.1).

However, perhaps the simplest workaround for this problem is drawing a gradient not from opaque black to transparent black (which is the default), but from opaque black to transparent white (or, if you will be using the shader on some other light color, to the transparent version of that light color).
changes the perceived gradient profile drastically, making its edges a lot smoother and more natural. On the downside, this may make the center of the elliptic gradient a little too sharp, which can often be fixed simply by scaling the shader object up somewhat.

Figure 10-13: Changing the gradient profile in a dark shader by using a fully transparent light color at the edge

Using gradients in design often involves overlaying several objects with semitransparent gradients. Figure 8 on the color insert demonstrates a colored water drop or a glass button which is in fact a group of six objects with various elliptic gradients.

The color modes of the Tweak tool (§8.7) can paint or randomize colors not only in flat color fill or stroke but in gradients, too. For gradients, the tool takes into account not only the position of the object with the gradient, but also the position of each gradient stop relative to the brush.

For example, you can recolor only the blue end of an object filled with blue-red gradient simply by painting over that blue end with a brush small enough to not touch the red. Color tweaking does not create gradients on objects that used flat color before, nor does it add stops, but only paints the stops of the existing gradients in the drawing.

As an illustration, let’s take a simple opaque-black to transparent-black gradient, add a lot of middle stops by repeatedly pressing [Insert], and randomize the lightness of the stop by stroking over the objects with a Tweak brush in Jitter Colors mode, with only the L channel enabled. Then, repeat the same for two more copies of the smooth original gradient, and overlay them all on top of each other with a little rotation. The resulting texture is a quite believable seascape in a mist.

Figure 10-14: Randomizing a gradient with the Tweak tool
10.8 Patterns

A pattern is a paint type (8.1.1) where an object’s fill or stroke consists of repeated copies of a tile. The tile can be anything: a single object (e.g., a bitmap) or a group of objects, using any style properties or Inkscape techniques. In this regard, patterns are a very rich and flexible feature. In another respect, however, patterns in SVG are quite limited: They can only use a simple rectangular grid of tiles with no rotations or reflections (compare, e.g., with the clone tiler which implements 17 different symmetry types, 16.6).

You cannot have both a gradient and a pattern on an object; they are two alternative paint types. If you want a transparency gradient on an object with pattern, read 10.7 on shaders or 18.4 on masks.

10.8.1 Creating Patterns

Unlike gradients, patterns don’t have a dedicated creation tool in Inkscape. Instead, just select the objects that you want to turn into a tile and choose Pattern → Objects to Pattern (Alt-I) from the Object menu.

The selected objects do not disappear and apparently don’t change; however, it’s easy to see that instead of the original object you now have a single rectangle selected. This rectangle is filled with the pattern made out of your objects, and it has exactly the size and position of their bounding box, which means that exactly one copy of the pattern fits into the rectangle. If you now drag the rectangle sizing handle (using the Rectangle or Node tool), you will see the other tiles as well:

![Figure 10-15: Creating a pattern from objects](image)

Now you can easily assign the new pattern to any object by choosing Copy and Paste Style from this rectangle (which you can then delete if no longer needed), or by choosing it from the pattern list in the Fill and Stroke dialog, as shown in Figure 10-16.

SVG allows you to set margins around tiles in a pattern to space them apart. Unfortunately, Inkscape does not yet support doing this via the UI. While you can do this in the XML Editor if you know how, a simpler approach is to add to the objects from which you create your pattern a transparent rectangle extending
Figure 10-16: The pattern paint in the Fill and Stroke dialog

beyond the edges of the other objects and thus adding separation between the
pattern’s tiles.

If you want to extract the tile objects back from a pattern in order to edit
them, select an object with that pattern and use the Object > Pattern > Pattern
to Objects command.

10.8.2 Editing Patterns

When you are in the Node tool or a shape tool, each object with a pattern fill
displays three editing handles that allow you to move, scale, and rotate the pattern
within the object. As with gradients, these handles can be anywhere on the canvas,
not necessarily on the object itself. Unlike gradients, however, these handles
are not connected by lines and cannot be selected nor moved by keys, but only
dragged by the mouse.

Also, unlike the Gradient tool, currently only a single selected object can
display its pattern handles. Patterns on stroke, while correctly rendered, are not
yet editable by handles at all.

X-shaped handle
Positioned in the top-left corner of one of the tiles (the “origin” tile).
Dragging this handle moves the pattern in any direction.

Square handle
Positioned in the center of the origin tile. Dragging this handle scales the
pattern. To make the scaling uniform (i.e., preserve the width/height ratio
of the tiles), drag it with \texttt{Ctrl}.

Round handle
Positioned in the middle of the top side of the origin tile. Dragging this
handle rotates the pattern around the X-shaped handle as an axis. Drag with
\texttt{Ctrl} to snap rotation angle to 15 degree steps.

From an aesthetic viewpoint, the major problem with patterns is the same
as their main advantage: repetitiveness. While necessary or at least acceptable in
technical illustrations, artistic drawings are rarely improved by an overly repetitive
rectangular pattern (even though they can sometimes use to a great effect some
more complex pattern types). Two simple things that often help are to scale the pattern up as much as possible (so that fewer copies of it fit into the object) and rotate it so it’s no longer horizontal/vertical and therefore does not look as regular.

10.8.3 Stock Patterns

The Objects to Pattern command is not the only way to add patterns to your document. Inkscape comes with a selection of simple stock patterns which you can reuse in your documents.

Select some object and switch it to pattern paint by clicking the Pattern button in the corresponding tab of the Fill and Stroke dialog. You will see a drop-down list (Figure 10-16) which contains your document’s patterns, if any, at the top, and a set of stock patterns at bottom, after a separator. To use one of the patterns, simply select it from the list.

- There is a selection of plain Stripes with different ratios of stripe width to gap width, in the range from 4:1 to 1:64. For example, the Stripes 1:2 pattern has gaps twice as wide as stripes. All stripes patterns exist in two versions: with black stripes and with white stripes (gaps are always transparent).
- There are two Checkerboard patterns with black and white odd squares (even squares are transparent).
- The Packed Circles option is a dense hexagonal pattern of black circles with transparent gaps.
- Polka Dots is a scattering of dots, designed to appear randomly but evenly distributed to mask the regularity of the repeating pattern. There are three size variants of this pattern (small, medium, and large dots) and two color variants (black and white dots).
- Wavy is a pattern of wavy lines with transparent gaps between them.
- Camouflage is a green-toned protective pattern such as that used by the military.
- Ermine is the traditional heraldic pattern, originating from a stylized representation of stoat furs with black tails.
- The three bitmap patterns, Sand, Cloth, and Old Paint, are based on seamless photographic tiles and allow you to add some natural texture to your drawing. All of them are grayscale, so you can make objects with these textures semitransparent and overlay them over other colored objects to “texturize” them.

Stock patterns are stored in the file patterns/patterns.svg in Inkscape’s share directory (typically /usr/share/inkscape on Linux, \inkscapel on Windows). You can add your own patterns to this file or replace it with any other SVG file containing the stock patterns you need.